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To get the most out of your ICLEF Electronic Publication, download this material to your PC and use Adobe 
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retail version of Adobe Acrobat®.   
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1. Searchable – All ICLEF Electronic Publications are word searchable.  To begin your search, click on
the “spyglass” icon at the top of the page while using the Adobe® software.

1. Bookmarks – Once the publication is opened using the Adobe Acrobat® software a list of
bookmarks will be found in a column located on the left side of the page.  Click on a bookmark to
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LEVERAGING LAW  
OFFICE TECHNOLOGY 

 

                9:00 A.M.           60 Tips, Tricks, Apps & Websites in 60-minutes 
                                                  This session covers all the latest developments in legal technology. We will cover where to go for  
                                                  legal-specific tech help, gadgets, and utilities that will help you work from home more  
                                                  efficiently, communicate with your clients better and improve the services you render, tablet and  
                                                  cloud-computing tips, ways you can securely share documents with clients and opposing  
                                                  counsel securely, law practice & life hacks, and more! 
 

                                                  26-Week Action Plan for Time Management & Digital Detox in the Face of Covid-19 
                                                  Maintaining focus before COVID-19 was challenging enough. Now we must add in the  
                                                  stresses of working from home, managing social distancing, keeping our families safe, and  
                                                  keeping our practice afloat. Achieving focus during this time can be extremely challenging!  
                                                  This one-hour session will show you how to achieve laser focus and work-life balance in the  
                                                  face of this pandemic. 
 

                                                  The Best in Mobile Apps – Apps for the iPhone/iPad & Android Devices 
                                                  Apps for legal professionals are constantly changing. In this fast-paced session, we will cover  
                                                  the 60 greatest hits and latest hits that will maximize mobility from your iPhone, iPad, or  
                                                  Android mobile device! 
                12:15 P.M.         Lunch Break 
                1:15 P.M.          PowerPoint Power Hour 
                                                  Based on Paul’s ABA Book, PowerPoint in an Hour for Lawyers, in this session, you will learn  
                                                  how to design professional-looking and effective PowerPoint presentations, without the use of  
                                                  endless bullet points and too much text. Specifically, we will cover how to work with photos,  
                                                  documents, document call outs, videos, audio recordings, text boxes, timelines, and much more. 
 

                                                  A Lawyer’s Guide to PDF Files (Acrobat or PowerPDF for Lawyers) 
                                                  Regardless of the PDF program you use, this session will show you the appropriate uses of  
                                                  PDFs. We will cover extremely important topics such as redaction, metadata removal and  
                                                  electronic document security, Bates Numbering, splitting/combining PDFs, reducing file-size  
                                                  for electronic case filing, review/comment, and PDF collaboration, adding signatures &  
                                                  stamps, routing PDFs for comments/feedback, and more. Finally, we will identify all the  
                                                  programs you can use for all of these functions (you are not limited to Adobe Acrobat or  
                                                  PowerPDF) and explain their relative pros and cons. 
 

                                                  Outlook Power Hour 
                                                  Lawyers and staff are generally drowning in email and many feel helpless when trying to get it  
                                                  under control. This session will show you how to use all of Microsoft Outlook's feature set to  
                                                  efficiently store, organize email (and attachments), and successfully deal with high email volume.  
                                                  This session also shows you how this powerful email and information manager helps better  
                                                  organize emails, contacts, calendar, and tasks. Tap into the latest and greatest features of Outlook. 
 

                4:30 P.M.           Program Adjourns 
 
 

WWW.ICLEF.ORG 

April 7, 2021 
 

Agenda 



 

 

 

                 

                 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

April 7, 2021 
 

Faculty  

WWW.ICLEF.ORG 

Mr. Paul J. Unger 
Affinity Consulting Group, LLC 
1550 Old Henderson Road, Suite S-150 
Columbus, OH 43220 
ph:  (614) 602-5572 
e-mail: punger@affinityconsulting.com 
 
 
 
 
 

LEVERAGING LAW  
OFFICE TECHNOLOGY 

 

mailto:punger@affinityconsulting.com


Paul J. Unger  
Affinity Consulting Group, LLC, Columbus, OH 
 

 
 
Paul J. Unger is a nationally recognized speaker, author and thought-leader in the legal 
technology industry.  He is an attorney and founding principal of Affinity Consulting 
Group, a nationwide consulting company providing legal technology consulting, 
continuing legal education, and training. 
 
He is the author of dozens legal technology manuals and publications, including recent 
published books, Tame the Digital Chaos – A Lawyer’s Guide to Distraction, Time, Task 
& Email Management (2017) and PowerPoint in an Hour for Lawyers (2014). He served 
as Chair of the ABA Legal Technology Resource Center (2012-13, 2013-
14)( www.lawtechnology.org/), Chair of ABA TECHSHOW (2011)(www.techshow.com), 
and served as Planning Chair for the 2016 ACLEA Mid-Year Conference in Savannah, 
GA.  He is a member of the American Bar Association, Columbus Bar Association, Ohio 
State Bar Association, Ohio Association for Justice, and New York State Bar Association, 
and specializes in document and case management, paperless office strategies, trial 
presentation and litigation technology, and legal-specific software training and 
professional development for law firms and legal departments throughout the United 
States, Canada and Australia. Mr. Unger has provided trial presentation consultation for 
over 400 cases. In his spare time, he likes to run and restore historic homes. 
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ICLEF 60 Tips, Tricks, Apps & Websites

Paul J. Unger
punger@affinityconsulting.com

Twitter:@pauljunger

www.pauljunger.com

Extras / Downloads

2

MS Office & PDF Tips

3
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Microsoft ToDo

FindTime by Microsoft

Bookings by Microsoft

Allows Client to Book 
Appointment Directly

on your Calendar 
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Add Attachments to Appointments & Tasks

Outlook Tip

9

In Outlook 
(copy & paste, or Insert Item) On Mobile Device

Add Locations to Appointments & Tasks

Outlook Tip

10

In Outlook On Mobile Device

My Templates
Place cursor > View Templates > Select desired  
Text to Insert



4

Add to My Templates

View Templates > 
Add Template > 
Type or Paste Text 

“Autotext” entries on an 
iPhone/iPad ($3.39/month)

Text Expander

P

1. Right-Click on Video > Trim
2. Adjust Start and Stop Time

Editing Video in PowerPoint
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1. Insert > Photo Album
2. Select ALL desired Pics

3. Re-order, Adjust, Create all at Once

Create Slides from Dozens of Pics
(never insert one at a time again!)

PDF, Fill/Sign, Save, Email
55 Seconds

Invest in Training, Period!

P
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Print, Sign, Scan, Save & Email
4 Min, 15 Sec

Invest in PDF Training!

P

Random Tips

19

1. Place yourself on Mute
2. Press & hold Spacebar to talk

Zoom Tip

P
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Online Meeting Transcripts
(Zoom, GTM, WebEx, Teams)

22P

Quick Easy Green Screen
For Virtual Backgrounds – Minimize Halo

23P
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“Simple Checklist” App (iOS)
(great for morning routines, processes, etc.!)

25

Clears/Resets
All Checkmarks so you

Can Use Checklist Again

P

“Do Things, Again and 
Again”

By Michael Galloy
@simplechecklistapp

“Autotext” entries on an 
iPhone/iPad ($3.39/month)

Text Expander

P

Apple Pencil + Notability, GoodNotes
Take Notes, Markup your CLE Materials, etc.

D



9

Apple Pencil + Notability or GoodNotes

No More Fat Wallets

Smartish Wallet Slayer
$14.99 on Amazon
3 Credit Cards
Cash
Protective Grip
Kickstand

Image and Video Screen Capture

Screenpresso ($29.99) (or Snagit)

P
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2 of these - Sceptre 27" 
Curved 75Hz LED Monitor 
C275B-144RN - $173 each

… on one of these –
HUANUO dual monitor stand 
- $30 (CDN $50)

Best Dual Monitors For A Great Deal

Samsung Curved 49” - $999.99
Dell UltraSharp 49” Curved - $1,499

Compare Single, Large Curved Monitors

Rename

Re-Order

PDF on the Fly

Send and Save – One 
Step

NetDocs Tip – Managing Email 
Attachments
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Easy Filing

Everyone Knows it is 
Filed

Case File is COMPLETE

Useful AI – NetDocs Predictive Filing

Upload your pleading and it will find relevant case 
law for you

https://casetext.com/ - Cara A.I.

Compose by CaseText

https://casetext.com/
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ASUS MB169B+ (USB 3) or MB 169C+ (USB-C) 15.6-Inch Screen - $180

Portable Full HD Second Monitor

800 g = 1.75 lbs

Mobile Pixels Duex Pro Portable Monitor for Laptops 
12.5" Full HD - $249

Portable Full HD Second Monitor (option 2)

800 g = 1.75 lbs

• iPad: Duet App ($16) – Win or Mac
• Android: AirDisplay ($5) or iDisplay ($5) – Win or 

Mac

Use Tablet as Second Monitor

43
P
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https://pro.luxafor.com/

Let People Know You’re On The Phone

Security Tips

46

Just as Important as a Strong Password … 
maybe even more

Two-Factor Authentication

47

https://pro.luxafor.com/
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Encrypt your PC - BitLocker

48

Encrypt your Mac – FileVault

49

Tunnel Bear $4.99/mo.

VPNs for Public WiFi
Pricing based on 12 mo.

Nord $6.99/mo.

Hide My $6.99/mo.
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PortaPow USB Data Blocker - $7  - 2 pack $12.50

USB Data Blocker

www.Sookasa.com

Encrypt Your File Sharing Service

Tresorit – YOU hold the Encryption Key!
Alternative to Dropbox, OneDrive, Box, Etc.

Encrypted Cloud Storage

http://www.Sookasa.com
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Tresorit – YOU hold the Encryption Key!
Alternative to Dropbox, OneDrive, Box, Etc.

Encrypted Cloud Storage

Centralize your Document Management!

Andy Huber 
andy.huber@imanage.com 

Chandler Shepherd 
chandler.shepherd@netdocuments.com

Rebecca Sattin
rsattin@Worldox.com

Laptop/iPad/iPhone/Android Devices

mailto:chandler.shepherd@netdocuments.com
mailto:andy.huber@imanage.com
mailto:rsattin@Worldox.com
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To Save

Inking Markup

Typical Redline Edits
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Windows 10 Tips

66

Windows 10 – Multi-Clipboard
Windows Key + V

67

Copy Items as you ordinarily
do  (Ctrl key + C), but use 
Windows key + V to access all 
copied items!

Works in MS Word as well! … 
anywhere & any program.

Notifications Icon 
(lower right 
corner) > Project 
> Connect to 
Wireless Display 
> Select your 
Smart TV

Present Wirelessly for Free in Windows 10
(no more messy wires!)

P
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Start button      > Windows 
Accessories > Quick Assist

Provide or receive assistance

Windows 10 Quick Assist

Emojis in all Windows Applications

Websites

73
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https://mediabiasfactcheck.com/

Facts Still Matter

PolitiFact.com

Snopes.com

FactCheck.org

Facts Matter!

https://mediabiasfactcheck.com/
https://mediabiasfactcheck.com/
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Where is that Image Online?
TinEye - Reverse Image Search

Photos, Scanning, Images

82
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Remove the background of an image for Free

www.remove.bg

Remove the background of any image for $1.99

www.remove.bg

Free & Also on Android
OCR
Can save directly to 
NetDocuments

Scan To PDF From Your Phone

http://www.remove.bg
http://www.remove.bg
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Free & Also on Android:
MS Office Lens
Adobe Scan

Scan To PDF From Your Phone

Fujitsu ScanSnap iX1500 - $420
30/60 ppm
Includes Kofax PowerPDF
4.3” Touch Screen
Scan business cards 
Scan to Word files
Auto-rotates
Auto-senses paper size
Auto-senses color or B&W
Scans front & back simultaneously

Best Desktop Scanner (NEW!)

P Antique ScanSnap

Symphony OCR
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iOS, Android

Web

Online Access

Share Albums 
for Free

PhotoMyne
$19.99/year, or $49 for 10 Years

89P

Thank You!!!

Paul J. Unger 
punger@affinityconsulting.com

www.pauljunger.com

mailto:punger@affinityconsulting.com
mailto:punger@affinityconsulting.com
http://www.pauljunger.com


TAME THE DIGITAL CHAOS -  
FOCUS & DIGITAL DETOX -  

26 WEEK ACTION PLAN 
C O P Y R I G H T  ©  2 0 2 1  

 

 
PAUL J. UNGER 

P UNG E R@A F F I N I T Y C ON S U L T I N G . C OM  

I can’t remember exactly where I was when I heard that China 
reported the first coronavirus death, but I was in an airport 
somewhere in North America.  I believe it may have been 
Newfoundland, but who knows.  I was on another marathon tour of  
travel for work.  I remember thinking that this sounds like another 
outbreak of  SARS.  Admittedly, I wasn’t terribly concerned, but I 
recall washing my hands extra-long throughout the day, and paid 
special attention to not touching my eyes, nose or mouth, a practice 
that I have grown accustomed to over the decades of  travel in 
airports. 

  A few weeks later, I woke up in New Orleans with the worst 
sore throat that I could remember in decades.  I muddled through 
speaking 6-hours a day throughout that week, elbow bumping 
people instead of  shaking hands.  People were not concerned, as 
they continued to walk into my personal space to ask questions and 
share stories even though my nose was red and I was clearly 
congested.  I must have gone through 4 boxes of  Kleenex in 2 days.  
I was a mess, but I made it through.  I woke up in Columbus on 
March 6th and fell right back asleep and did not get out of  bed for 
3 days.  I started a self-quarantine March 6th, 2020 and have been 
home ever since. I remained sick for the next 4+ weeks.   

I never thought that a year later I would still be working from 
home.  As of  the date of  writing this paper, more Americans are 
dying of  Covid-19 than U.S. soldiers died each day in World War II.  
Other than trips to the grocery store and to visit my mother, I am 
restricted to home.  While I feel that I am tolerating this situation 
fairly well today, there are days that I do not. 
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On bad days, and sometimes bad weeks, I am experiencing many 
of  the same problems as so many others similarly situated.  
Problems: 

• Sleeping 
• Focusing 
• Doom-scrolling/surfing 
• Monkey Mind 
• Mild depression 
• “Cabin Fever” 

 
Sadly, many people are having even more severe problems.  

Substance abuse is up … way up!  Non-prescribed Fentanyl use is 
up 32%.  Drug-related overdoses are up 18%.  Unemployment … 
suicide … death of  friends and family. 

 

  In researching ways to improve focus and sleep during the 
pandemic, I ran across some interesting research.  Many of  the 
distraction and time management techniques that I have been 
teaching for years are heavily used.  I also picked up some new tools 
and knowledge.  In this paper/plan, I thought it might be helpful to 
share those and help you assemble an Action Plan.  However, I 
present these techniques in a slightly different way . . . as a “NOT to 
do list.” Here are 26 “Nots” over 26 weeks to detox yourself  from 
information overload and improve your focus. 

DON’T TRY TO BOIL THE OCEAN! 
First and foremost, focus on each item one week at a time. Go 

out of  order if  you want. You make the rules and can tweak the 
processes as needed. While one item per week may not seem fast 
enough for you, let me assure you, if  you are following 80% of  these 
rules 6 months from now, you will be in great shape. Have a little 
patience and execute each item consistently. Think of  the long game. 
When you feel ready, move on to another item. If  you want to go a 
little faster, go ahead. Be an overachiever. If  you stumble, just stop 
and regroup. Take a week or two and focus on the items that you 
have already executed. Don’t take on a new item until you are 
comfortably back on the wagon.  
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PREPARE & CARE FOR YOUR BRAIN 

Week 1 - Do NOT Neglect Sleep!  

Defeating “Coronasomnia”  
Insomnia was a problem before Covid-19.  It is no surprise that 

Covid-19 has piled on even more reasons to lose sleep:  stress, “cabin 
fever,” anxiety, depression, unemployment, death of  loved ones.  
The list is endless.  “It’s a problem everywhere, across all age 
groups,” … “the increase [of  insomnia] is enormous,” said Angela 
Drake, a UC Davis Health clinical professor in the Department of  
Psychiatry. 

According to the U.S. Centers for Disease Control and 
Prevention and the National Sleep Foundation 
(www.cdc.gov/sleep), most healthy adults need 7–9 hours of  sleep 
per night. Good sleep quality is very important. Getting up several 
times a night or waking up multiple times per night with breathing 
problems can adversely affect the quality of  your sleep.  

According to research at the University of  Toronto, even just 
one night of  sleep deprivation showed significant decline in 
cognitive performance. fMRI studies showed declined activity in 
certain regions of  the prefrontal cortex, the same area of  the brain 
that allow for decision-making, problem-solving and planning 
(Front. Hum. Neurosci., 22 April 2014). 

WebMD states that poor sleep leads to significant problems, 
some of  which are very serious: 

• Moodiness 
• Anxiousness 
• Paranoia 
• Depressed mood 
• Difficulty understanding new concepts 
• Forgetfulness 
• Lack of  focus 
• High blood pressure 
• Severe headaches 

http://www.cdc.gov/sleep
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• Diabetes 
 

Dr. Drake from UC Davis provides these tips for better sleep: 
 

• Keep a normal daily routine: “If  you’re working from 
home, keep the same schedule as if  you were going to 
work,” Hardin said. “Don’t sleep in or stay up late. When 
that alarm rings, as painful as is, get up.” And give yourself  
a break during the day, just as you would in the office. Take 
a lunch break or go for a walk or just get outside. 

• Create and keep a going-to-bed routine: “Slow down at 
the end of  your day,” Drake said. “Begin turning down the 
lights about a half  hour before bed. Bright lights will keep 
your brain from producing natural melatonin (a hormone 
that is part of  our natural sleep cycle and helps us sleep). 

• Avoid screens in the bedroom: The blue light from 
cellphones, tablets and computers signals our bodies to stay 
awake and not release melatonin. “I know this is hard for 
people, but please put down the electronics. TV is OK but 
it’s even better to read a book.” Hardin said. “You don’t 
want that light from a screen right in your face.” 

• Don’t use your bedroom, and especially your bed, as 
your office: “You want to train your brain that this is the 
place where you rest,” Drake said. “You don’t want it saying, 
‘This is where you work.’ If  you have nowhere else to work, 
at least don’t work on the bed.” 

• Get some exercise during the day: It reduces stress and 
keeps our bodies in their normal rhythms. It’s best, however, 
to finish the exercise a few hours before bedtime to give 
your body time to cool down and slow down. 

• Don’t take naps: A short power nap won’t hurt, if  it’s not 
too late in the day, but sleeping longer will throw off  your 
sleep cycle. “That’s another reason not to worry about one 
bad night,” Drake said. “It’s better to be tired for a day and 
then get a good night’s sleep.” 

• Get some sunlight: It helps keep our circadian rhythms in 
pattern so we produce melatonin at night, not during the 
day. 

• Don’t eat dinner late: “If  you’re going to bed at 11 p.m., 
try not to eat after 7 pm or so,” Hardin said. “You have to 
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give your body time to digest it. When you go to sleep, your 
body wants to shut down all the metabolic work, including 
digestion.” 

• If  you wake up in the middle of  the night and can’t 
sleep, get out of  bed: A change of  scenery helps you reset, 
but keep lights low and don’t do anything that gets you 
energized. “If  you can’t sleep for more than a half  hour, get 
up and leave the bedroom,” Hardin said. “Do something 
simple and monotonous in dim light.” 

• Cut back on news and social media, especially in the 
evening: “I’ve had to limit the news consumption for some 
patients,” Drake said. “Our brains are not really wired to 
handle all the constant news alerts and headlines. They’re 
constantly ringing our alarm bells. It’s like the car alarm in 
our brain is constantly going off.” 

• Go easy on the alcohol and caffeine: They both throw 
off  your sleep patterns. Alcohol can help you fall asleep, but 
not necessarily stay asleep or sleep well. “Not all sleep is 
equal,” Hardin said. “We want the right sleep.” 

• Be careful with sleep medication: Over-the-counter 
medication can give you fitful sleep or leave you drowsy in 
the morning, and prescription drugs can create an 
emotional dependence. 

• Try learning to meditate with one of  the many apps 
available: “I’m a big believer in meditation,” Drake said. “It 
can improve sleep and it emphasizes the importance of  our 
mind-body connection. It does take a little practice, but it 
lowers our stress hormones. We have some new 
neuroimaging research that has demonstrated the positive 
changes in the brain.” 
 
(UC Davis Health, Newsroom, September 23, 2020) 
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Week 2 - Do NOT Worry So Much!  
“Worrying doesn’t take away tomorrow’s troubles. It takes away 

today’s peace.”      
- Unknown 

Worrying can be good, but not when it is excessive. For instance, 
if  you have a presentation tomorrow in front of  your peers, or a 
hearing before a new judge, a little bit of  “healthy” worrying can be 
extremely helpful so you can prepare. On one hand, your worries 
can make you and your organization more prepared for situations.  
On the other hand, when your worrying is excessive, it can be 
annoying and even outright paralyzing. It can bring projects to a 
complete halt.  

The science behind worrying is fascinating.  The same circuits 
in the frontal lobes of  your brain that allow for superior human 
intelligence: decision-making, problem-solving, and planning, are 
also responsible for worry & anxiety.  When higher-functioning brain 
regions are preoccupied with worry, you can’t access them for the 
other things like decision-making, etc.  Worrying takes precedent. 
When this happens, your amygdala hijacks your brain and puts the 
brakes on higher-level thinking. 

Further, according to the Chopra Center (www.chopra.com), 
worrying too much can affect both mind and body: 

• Disrupted sleep 
• Headaches 
• Concentration difficulties 
• Nausea 
• Muscle tension 
• Exhaustion 
• Irritability 
• Elevated cortisol (stress hormone) 
• Difficulty making decisions 

 
Breaking the cycle of  worry can be difficult but let me share with 

you two practical strategies that help me. 

http://www.chopra.com


Tame the Digital Chaos Page 7 

First, practice mindfulness or another form of  meditation. If  
you are unfamiliar, I strongly recommend a few apps to try on your 
smartphone that will lead you through short, but very helpful 
sessions: 

• Headspace 
• Breathe 
• Calm 

 
Second, start a journal to write down those things that are 

worrying you, and then get back to the work at hand. Also use the 
journal before you go to bed to write down how you feel. Many 
times, putting it down on paper can bring clarity. At a minimum, it 
will reduce anxiety.  I write down micro-entries (very short bullet 
points) in my daily planning journal.  It requires 1-2 minutes of  my 
time. 

Week 3 – Do NOT Doomscroll or 
Doomsurf   

Ever find yourself  unable to put your device down, as you scroll 
through the infinite number of  social media posts on Facebook and 
the like?  Most of  it is either bad news or someone painting their 
lives as perfect with their perfect white picket fence, perfect new job 
promotion, and perfect 6-pack abs after “working out 365 perfect 
straight days!”  Right?  It’s downright defeating.  What are we looking 
for anyway?  Some ray of  hope?  The reality is that it is not only a 
huge time-suck, but it is harmful to our mental health.  What can 
you do? 

• Set Boundaries: I found during the presidential campaign 
season that I had to put limits on my exposure to certain 
politicians and my use of  Facebook.  For me, it wasn’t 
enough to set aspirational boundaries, I had to utilize the 
iOS Screen Time function to block myself  from trying to 
knock some cyber sense into some of  my family and friends 
because they did not share the same political and moral 
beliefs.  With Screen Time (and similar functions on an 
Android device), you can completely block yourself  from 
apps during desired hours, and you can limit your total time 
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to however much time you designate.  For instance, no more 
than 30 minutes a day on Facebook. 

• Replace Doomscrolling with Something Healthy: If  
during business hours, anytime you feel the urge to jump on 
Facebook, instead dedicate that time to reaching out to a 
colleague or client to check in on them.  If  during non-
business hours, write a letter, card or text message to a 
family member, or jump on a video call with them.  Read a 
book, go for a walk or run, do pushups, stretch, journal, or 
clean out a closet. 

Week 4 - Do NOT Ruminate – Learn 
to Tame “Monkey Mind” 

Rumination is the process of  continuously thinking the same 
negative or sad thoughts.  It occurs during the day, as well as during 
bouts of  insomnia.  When some ruminate, they also self-reflect and 
problem-solve.  That sometimes lures people into believing they are 
doing something healthy or productive. 

Related to rumination, but a bit different is “Monkey Mind,” or 
racing thoughts.  Where rumination is someone thinking about the 
same negative thought, Monkey Mind is someone thinking about 
many different thoughts.  For example, you are working late, and you 
wish you took that job in Canada, which reminds you that you may 
want to buy a Thermador, but which one and you don’t have the 
money.  You next start thinking about cooking classes instead, which 
reminds you of  your ex’s terrible cooking, and how you have to fix 
that nagging roof  leak.  These thoughts are typically negative as well, 
and they are all over the place – like a monkey swinging from limb 
to limb.  It is worried, unsettled mental chatter.  We sometimes call 
it catastrophic thinking because nothing goes well, and it usually 
results in stress over unresolved problems. 

Like worrying, fear and jealousy, rumination and monkey mind 
activates, … you guessed it … the prefrontal cortex, the part of  the 
brain that is also associated with logical thinking. 

Mindfulness.  Practicing mindfulness quiets the amygdala, 
which reduces the release of  cortisol.  Mindfulness is a form of  
meditation that often involves deep breathing.  It is an incredibly 
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important tool because once the emotions are triggered, we need a 
practical strategy to stop the racing.  To learn about these techniques, 
I recommend either a therapist, life coach, group meditation, or if  
none of  those appeal to you, there are numerous apps that will 
privately lead your through these exercises like Headspace, Calm, or 
Breathe (discussed above). 

Rumination Diary. Equally important is learning the 
environmental triggers and figuring out how to manage them.  Many 
experts recommend keeping a journal to record when it happened, 
what happened right before the ruminations started, how did it make 
you feel, what were your thoughts, what stopped it? 

If  Causing Insomnia, Get out of  Bed.  If  rumination is 
preventing you from falling asleep, it is important to get out of  bed 
slowly and go do something calm like light reading or even 
meditation. Journaling your thoughts is often recommended, even at 
night.  Stay away from bright light or activity that will keep you falling 
back asleep.  Once calm and the rumination stops, try to return to 
bed.   

Positive Talk + Time Limit.  You can also combat the negative 
thoughts with mind racing positive thoughts.  This lessens the 
likelihood that we begin to obsess over the negative in the first place.  
Whatever the case, set a time limit of  10 minutes – not a minute 
longer.  After the 10 minutes is up, say to yourself  “no thank you, … 
I have already thought about this enough.  It is time for peace.”  

Week 5 - Do NOT Go Without Deep 
Breathing 

One part of  mindfulness that I find incredibly helpful is deep 
breathing (typically 6 breaths per minute).  Many promote a 3 count 
while inhaling, and a 3 count while exhaling, but I have seen small 
variations of  this work just as well.  While I talk about this topic in 
multiple places within this paper, it is so important, inexpensive, and 
easy that I wanted to dedicate a full week for you to explore and 
perfect the practice.  Perhaps start with deep breathing, and if  you 
like the results, think about mindfulness or another form of  
meditation. 
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A 2017 study published in Frontiers in Psychology showed that deep 
breathing resulted in significant improvement on attention, stress 
and cortisol levels.  Deep breathing calms the Amygdala, which 
reduces the secretion of  cortisol (see 
https://www.ncbi.nlm.nih.gov/pmc/articles/PMC5455070/).  

Week 6 - Do NOT Neglect Your 
Brain by Feeding it Poor Nutrition 

We too often fill our bodies with unhealthy food that can impair 
our ability to focus. In the short term, we can experience a food 
coma after eating too heavily at lunch or consuming too much sugar 
when snacking. It leaves our brains foggy. In the long term, we may 
develop chronic diseases that limit our activities and enjoyment of  
life. 

An easy way to achieve better nutrition is by implementing a 
handful of  healthy boundaries. Here are some examples of  healthy 
food boundaries that will lead to weight loss and healthier lifestyle, 
without having to commit to a formal diet.  Adjust these examples 
to help you control some of  your own vices. 

• I will not consume more than one 3 oz bag of  potato chips 
per day. 

• I will not consume more than 250 calories of  sugary snacks. 
• I will not eat after 7:00 pm. 
• I will always eat a single serving of  plain oatmeal for 

breakfast Monday through Friday. 
• I will not consume more than 2000 calories in a single day. 
• I will eat no more than 1 small bowl of  ice cream per week. 
• My dietary intake will be 90% plant-based and 10% animal 

protein. 
• I will replace 90% of  my current unhealthy snacks with 

fruits and nuts. 
• I will drink no less than 12 glasses of  water per day. 

 
  

https://www.ncbi.nlm.nih.gov/pmc/articles/PMC5455070/
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GIVE YOUR BRAIN A SENSE OF CONTROL 
When you feel in control, it calms the amygdala and stress 

response.  This is why we always feel more focused and less stressed 
when we have a plan. 

Week 7 - Do NOT Begin Your Day 
Without a Plan 

Instead of  jumping into email, begin your day by operating from 
your daily roadmap. Commit to a 5-minute planning session with 
yourself  at the end of  the today for tomorrow or start your day with 
a 5-minute planning session.  If  you don’t have a plan, you will 
become part of  someone else’s plan! 

 Use the Tame the Digital Chaos daily planning sheet, or another 
commercial planner like Best Self  Journal or Covey, for this and time 
block your day on paper, remembering to state some 30,000-foot 
goals for the day.  Blank planning sheets are included at the end of  
this handout.  Recite 3 things that you are thankful for. Put a plan 
together for your day before diving into email. You can always adjust 
as the day unfolds but start with a plan! Consider doing your plan at 
the end of  the previous day and spend a couple minutes in the 
morning reviewing it instead of  jumping into email.  Also be sure to 
cross things off  from your list as you complete them to give your 
brain a shot of  feel-good dopamine.   

 



Tame the Digital Chaos Page 12 

Week 8 - Do NOT Star t Your Day 
Without a Team Huddle 

Instead of  diving right into your email or your first appointment 
or project, after your 5-minute daily planning session (above), have a 
quick huddle with your immediate team. We call this the “lightning 
round.” Each person has 60 seconds to recite what they have going 
on that day in detail, and broadly for the rest of  the week. This 
encourages communication and awareness of  projects, and almost 
always results in shifting some tasks and schedules around to better 
distribute work and help each other.  It also reduced interruptions 
during the day because everyone is more aware of  deadlines around 
the team. 

If  your team works from home or multiple locations, use tools 
like Zoom, Teams, or GoToMeeting.  Be disciplined about time.  
Beware of  “meeting creep.”  If  the meetings constantly go over, it is 
no longer a huddle, and people will quickly grow annoyed.  Larger 
teams should think about breaking into smaller huddles, so this 
doesn’t turn into a 30 minute meeting. 

Week 9 - Do NOT Begin Your Week 
Without Weekly Planning 

A once-a-week “get organized” deep dive is absolutely essential 
to successful time and distraction management. This is a 60-minute 
commitment once a week. It will help you frame realistic daily 
planning, clean your workspace, eliminate piles, review all tasks and 
deadlines on your plate, catch up on tasks that slip between the 
cracks, and keep focused on the big picture goals that you want to 
achieve. It will help you stay driven. Failing to plan is planning to fail. 

It is extremely helpful do your weekly deep dive planning session 
on the same day and time each week.  Performing this one-hour 
ritual on the same day and time each week will make it infinitely 
easier to develop a habit of  engaging in this important planning.  

Try to do your deep-dive 2 to 3 days before starting the next 
week. 



Tame the Digital Chaos Page 13 

 

 

Week 10 - Do NOT Fail to Write 
Down Tasks and Random Neural 
Firings  

The main reason tasks and deadlines slip between the cracks is 
because people fail to immediately write them down in an organized 
system. The reason they don’t enter them into an organized system 
is because they are too cumbersome to record, especially when they 
are not at their computer. 

The answer to this problem is an application like Microsoft 
ToDo. ToDo is available on your PC, Mac, Tablet, iPad, iPhone, 
Android Phone, and on the web. No matter where you access that 
list, it updates it everywhere. Most importantly, it is a beautifully easy-
to-use program: 
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To add icing on the cake, Microsoft ToDo integrates seamlessly 
with Microsoft Outlook. Any task that you create in one application 
will be created in the other. 

Week 11 - Do NOT Keep 20 
Different Lists  

Having tasks in too many locations is a major faux pas. If  you 
have to look in 20 places for information or tasks, you are bound to 
miss something. Microsoft ToDo is a great solution for this problem 
because you can create and organize your lists very easily. Keep your 
task lists simple. Here is how that looks in Microsoft ToDo: 

 

Week 12 - Do NOT Use Poor 
Descriptions in Your Task Lists! 

When you read descriptions in your task list, are they vague? Do 
you know exactly what you need to do next? Here is a common 
example of  a task list that I see when I do one-on-one coaching: 

• Work on the Smith Case 

• Jones Hearing 

• Davis Settlement 

• Joe’s Annual Evaluation 
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While you may have known what these descriptions meant when 
you wrote them, (1) none of  them articulate exactly what next action 
step you must do, and (2) chances are if  you know what those next 
steps are right now, you probably will forget those details by 
tomorrow or the next day. One of  the primary reasons why we 
procrastinate is because we don’t know that next step or where we 
left off.  

Using one of  the examples above, I can’t start Joe’s Annual 
Evaluation until I receive his HR information from Anne and I get 
Joe’s self-evaluation. So, a better way to record the task is to provide 
the details of  the next steps. This is how that would look in a task 
list like Microsoft ToDo: 

 

1. Main Task Description 

2. Steps or Subtasks with Detail 

Week 13 - Do NOT Underutilize 
Your Calendar 

Many people simply leave tasks, deadlines, and ticklers in their 
task list and set up “Reminders.” While that works for some people, 
it doesn’t work for the majority of  people. Having a task on a task 
list is vital because it stays there until it is marked complete. However, 
if  it is 1 of  100 other tasks, it might get lost in the weeds. Scheduling 
the task on your calendar is important because you can see it clearly 
on a particular date. That date may be the date that it is due, or the 
date that you are blocking off  time to work on it.  Having the task 
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in both places is important because if  you fail to get something done 
on a certain day and it is only recorded on the calendar, you may fail 
to remember to do that task unless you go back and look at a 
previous date. If  it is on your task list also, it will still be there as 
unresolved. This dual system is key for certain tasks that have 
deadlines. I don’t think it is essential for all types of  tasks. For 
instance, I would rarely, if  ever, put “buy milk and eggs” on my 
calendar.  However, if  I must have a contract drafted by a certain 
date, I will most likely have that in my task list, in my calendar on the 
date that it is due, and in my calendar as an appointment with myself  
to work on it. 

There are three categories of  events that people fail to record 
on their calendar: 

• Time Blocking - appointments with yourself  to do a task. 

• Ticklers - reminders to check in with someone or see if  you 
received something from someone. 

• Deadlines - hard deadlines for a project or deliverable (e.g., 
draft a contract for the Davis case). 

The bottom line is that we must get in the habit of  recording 
tasks and scheduling deadlines and block off  time to perform that 
work on our calendar. 

Example—Opinion Letter on § 501(c)(3) Status of  ABC Corp. 
This is DUE on December 1, 2020 to the client. What entries might 
you want to make? 

• Record the task in Microsoft ToDo with the DUE DATE 
and a reminder 3 days before at 9 am. “ABC Corp - Opinion 
Letter” with all needed details in the steps or notes section. 
(TASK ON TASK LIST). 

• Create an appointment in Outlook on December 1 at 9 am: 
“ABC Corp - Opinion Letter DUE to Alex Smith” 
(DEADLINE ON CALENDAR). You may also want to 
record needed deadlines within any firm-required systems, 
like a practice management program or a docketing system. 
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• Create an appointment in Outlook on November 17th from 
2–5 pm to work on Opinion Letter (TIME BLOCKING). 

• Create an appointment in Outlook on November 26th from 
3–5 pm to finalize Opinion Letter. (TIME BLOCKING) 

• Create an Appointment on November 13th to check in with 
associate Barb on the status of  her research and opinion 
letter (TICKLER). 

 

MANAGE DISTRACTIONS 

Week 14 - Do NOT Keep Your 
Outlook Inbox Up on Your 
Computer Monitor All Day  

Stop checking your inbox 70+ times a day!  Your inbox is one 
of  the most disruptive tools if  you are trying to focus on project 
work, billable work, or deep level work. It’s like choosing to write a 
complex brief  or letter in a war zone or a nursery full of  screaming 
children. Literally every 2 to 3 minutes, a bomb is landing in your 
inbox. How can one possibly focus while working in an environment 
like that? Instead, skim your calendar in the morning and decide how 
many times and for how long you can batch process your emails that 
day. Every day will be different. Aim for something reasonable like 
5 times a day (the average American worker checks email an idiotic 
74 times a day!). 

Be more deliberate about when you check email by batch 
processing email, following the 3-minute rule and the 4 Ds. For 
instance, instead of  checking email 74 times a day, you may only 
check it 5 times a day: 
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Use your dual monitors to display documents or information 
that is relevant to the work that you are performing, not your inbox. 

 

 

Week 15 - Do NOT Turn on 
Notifications 

We all should be aware of  the perilous cost of  task-switching. 
Notifications are invitations to task-switch. They are like a dozen 
little devils sitting on our shoulder, tempting us to do everything 
except what we are supposed to be doing, and those devils have a 
direct hotline to our brain. Why would we give the world a hotline 
to our brain? Turn all notifications off—and I mean ALL of  them, 
including those on your smartphones. In Outlook, email 
notifications can be turned off  by navigating to File > Options > 
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Mail and deselecting the four different methods of  notifying you 
when a new message arrives.  

 

 

Week 16 - Do NOT Answer All Calls 
as They Come In 

We never want to miss an important call, but you one must 
balance this with work that needs to be finished. If  your job 
is sales/business development, you probably will take more 
calls as they come in, even from unknown callers. If  your job 

is mostly project work, you should answer fewer calls as they come 
in. If  you have a receptionist or use service like Smith AI virtual 
receptionists (www.smith.ai) Ruby Receptionists (www.ruby.com), 
perhaps they can field and filter these distractions. When we take 
calls from unknown callers, we run the risk of  derailing our day by 
getting sucked into a conversation that we aren’t prepared to resolve. 
It is always a little dangerous. Retrieve the message, do any needed 
research, and then call the person back in a timely manner with all 
the needed answers (batch return telephone calls, just like we should 
do with emails). 

Week 17 - Do NOT Multitask!  
It is not enough to say that multitasking is bad. We need to 

practice single tasking. We need to clear our desks and our multiple 
monitors of  information that is not directly relevant to the project 
that we are executing. One way to do this is using the Pomodoro 
Technique®. Pomodoro is an easy technique that utilizes the 25-
minute tomato timer. We single-task (preferably deep-level 
work/project work) for 25 minutes and then take a break and do 

http://www.smith.ai
http://www.ruby.com
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whatever we want for 5 minutes. In other words, we work in 
intervals. The human brain functions very well maintaining attention 
to a single task for 25 minutes. After 25 minutes, we begin to lose 
focus. By giving ourselves a 5-minute break, we easily can return to 
and focus on deep-thought work for another 25 minutes. This 
technique will make a huge impact on productivity and will also help 
combat procrastination. Think about it—we can endure even the 
most tedious dreaded task for 25 minutes, right? Once we get a little 
momentum going and we get immersed in the project, it becomes a 
lot easier. If  you feel like adjusting the time a bit, go for it. I many 
times go 40 minutes with a 10-minute break. 

If  you really like this concept, the Pomodoro Technique book is 
a quick read and very affordable. See 
https://francescocirillo.com/pages/pomodoro-technique. 

 

 

Week 18 – Do NOT Juggle Tasks 
Without Some Juggling Tools 

Let’s face it, sometimes we cannot avoid juggling emergencies.  
We are forced to task-switch.  If  you aren’t one of  the lucky 1-2% 
of  the population who is a “supertasker,” you better have some 
juggling tools at your disposal to mitigate the cost of  task-switching. 

1. Know Where You Left Off 

Have a dedicated place to write down or mark where 
you left off  and note when you get back, “I will do 
__x__.”  Before jumping to another task, take 15 
seconds and write down this information.  For instance, 
I draw a little hazard icon and write down where I left 

https://francescocirillo.com/pages/pomodoro-technique
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off/what I must do next.  Sometimes I will even use a 
highlighter to draw more attention to it. 

Finish review of restrictive covenant 
clause, then draft Landlord Duties. 

2. Quick Deep Breathing – Mind Check Before 
Commencing the New Task 

You don’t have to commit to a 15-minute mindfulness 
session with yourself  to experience the benefits of  deep 
breathing.  You can benefit from 15-30 seconds and you 
don’t even need to close your eyes if  you don’t want to.  
I discuss the benefits above, but in short, even a few 
deep breath starts calming our amygdala in our brain. 

Here’s how:  Shift your breathing from your chest to 
your belly.  Breathe in slowly (a 3-count) and say the 
word “Relax” on your inhale and then exhale slowly and 
say the words “my Chest” (again on a 3-count). 

Then do your best to get oriented and then dive in. 

3. Timer to Switch Back 

When I used to work in a restaurant kitchen, we had to 
juggle many things.  I could have 5-10 different food 
items cooking at once.  It was impossible to manage 
without timers. 

With office work, we are often doing one thing and then 
get pulled into a telephone call or a conversation.  To 
remember to switch back, set a timer.  The easiest way 
is to use your smartphone: 

“Hey Siri, set a timer for 15-minutes.” 

4. Use Checklists 

If  you constantly get pulled in multiple tasks, use 
checklists to minimize the possibility of  missing 
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something important.  It can also make more cognitive 
demanding tasks less cognitively demanding because 
you don’t have to memorize as much. 

5. Pick Tasks That Use Different Areas of  the Brain 

It isn’t always possible, but if  you can, pick a motor task 
that doesn’t compete with a cognitive task. 

For example, applying labels on envelopes (motor task) 
or warming up lunch in the microwave (motor task) 
along with a cognitive task like returning a call to your 
spouse.  Be careful though, you may end up 
microwaving your envelopes if  you try too much.   

Week 19 - Do NOT Carry Your 
Phone 24/7 

Let’s face it, that smartphone is a ball and chain. If  you don’t 
believe me, take a “phone fast” by leaving your phone in your car’s 
glovebox or briefcase for a half  or whole day while you are at work. 
Let your loved ones know how to reach you at the office in case of  
an emergency. You will feel liberated. It is incredible how often we 
look at our phones during the day.  It is having a terrible impact on 
productivity. 

If  for some reason, you cannot leave your phone in your 
briefcase, then turn off  notifications on your phone and set up a VIP 
list for exceptions (a sick loved one at home, etc.). 

Also, take advantage of  screen-limiting technology. For 
example, on your iPhone, you can use Screen Time. Go to Settings 
> Screen Time. You can view reports about how much time you 
have spent on your phone, within certain apps, as well as block 
yourself  from apps during specific hours. I do this during election 
season to prevent myself  from engaging in useless debates on 
Facebook. I find it extremely effective. 
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Week 20 - Do NOT Live in Social 
Media 24/7 

Check social media 1 or 2 times at the most during the workday 
(unless you are engaging in business development or marketing). In 
fact, think about taking a 30-day “social media fast” from all social 
media, and I mean all of  it - Facebook, Instagram, LinkedIn, etc. - 
ALL OF IT. It is addictive and a huge productivity zapper. Give 
yourself  a limit of  15 minutes a day. Set boundaries for yourself. 

Social media companies design their platform using incredibly 
manipulative techniques to draw us in. They utilize color, monitor 
what we are searching for on Google to customize feeds that get 
your attention, and worst of  all, using artificial intelligence, they 
know exactly what kind of  posts are going to pull you in (political 
posts, posts about hot issues, etc.). Sometimes the best way to avoid 
this enticement is to stay away, especially during business hours. 

Week 21 —Do NOT Micro-Manage 
and Solve Everyone’s Problems!  

When you micro-manage people, you are inviting dozens of  
interruptions during the day.  Empower the people that you pay to 
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solve problems on their own and think for themselves. When 
colleagues come to you and ask what they should do, or ask how to 
solve a problem, the first thing out of  your mouth should be: 

“How do you propose that we solve this problem?”  

or 

“I want you to think about this and do a little research and present to 
me 2 or 3 possible solutions and then let’s talk.”  

We need to get our team members to a place where they know 
how to problem-solve.  You need to be able to delegate those 
problems and trust that they get resolved.  Build your team members’ 
confidence enough so they can make more decisions on their own, 
or, at a minimum, present the right recommendations to you. 

One of  my favorite books on effective delegation is The One 
Minute Manager by Kenneth Blanchard and Spencer Johnson. It is 
available on Amazon for less than $20. 

 

Week 22 - Do NOT Create More 
Emails for Yourself 

Don’t create more emails for yourself  from your responses. As 
an example, when trying to schedule an appointment with someone 
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or multiple people, use applications like Doodle or Microsoft 
FindTime, rather than asking when everyone is available to meet. 
Send a quick, easy-to-create poll with FindTime or Doodle where 
everyone can vote on their preferred times. It holds all proposed 
dates on your calendar as tentative until the poll is closed and you, 
as the organizer, can pick the final time. Then the program sends the 
invitation out to all participants. It makes herding cats easy as pie, 
and you aren’t blowing up everyone’s inbox with dozens of  emails 
from the responses. 

 

Also, to avoid getting 10 more questions from your response, 
don’t be vague in your emails. Always think about how to resolve the 
email without sparking more conversation.  

Week 23 - Do NOT Process Emails 
All by Yourself 

If  you get a large volume of  email every day, think about 
allowing a trusted assistant to help you process and respond to the 
email. I realize this may not be possible right away, and maybe never 
possible for some people, but if  it is, you should strongly consider 
it. First and foremost, you need an assistant that you can trust with 
sensitive information. Second, you may need to set up an alternative 
email account so you can receive HR-related emails or emails from 
your partners, without your assistant having access to that content. 
Third, you need to contact your IT folks to have them give your 
assistant access.  If  using Outlook, only your Microsoft Exchange 
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administrator would be able to give these permissions to your 
assistant. 

Week 24 - Do NOT Do Shallow Work 
First Thing in the Morning  

Many times, it is best to tackle deep-thought work early in the 
day when you are rested. Dive into deep-thought work like writing 
and projects early morning when you have the most energy. There is 
little question about it . . . our brains function better following quiet 
time or sleep. We also know that we can be highly productive while 
the rest of  the world is sleeping because there are far fewer (if  any) 
interruptions. This can be one of  the most productive times of  the 
day. 
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GET TRAINING & GET ORGANIZED 
 

Week 25 - Do NOT Neglect 
Adequate Training  

Most professionals neglect training for themselves and for their 
team. This happens at multiple times and on multiple levels: 

• Onboarding: We fail to have an adequate training plan for 
onboarding new employees. Instead, we train our people 
how to drive by throwing them onto the highway. 

• Ongoing Training: Education should never stop. That’s 
why we have the phrase “Continuing Education.” 
Technology never stops, new situations continuously arise, 
and laws are constantly changing. This means we need to 
stay on top of  those changes and adapt. 

• Software Training: Invest in software training whenever 
possible. Live onsite hands-on training is always the best, 
but it isn’t always possible. Look at tools like 
www.AffinityInsight.com or www.lynda.com. These 
solutions provide all-you-can-eat, on-demand online 
training for your employees, covering most of  the software 
solutions that you use on a daily basis. 

• Process Training: Train your people how to improve your 
processes, not just how to perform the existing process. 
This means you need to explain the “why” behind the 
process, in addition to the process. 

At the end of  the day, when people know how to do their job 
and the “why” behind it, they will always be able to do things more 
efficiently and be able to focus on the tasks with much less stress. 
Education and skills bring clarity and focus. Not knowing how to do 
something properly can be very stressful and counterproductive. 

  

http://www.AffinityInsight.com
http://www.lynda.com


Tame the Digital Chaos Page 28 

 

Week 26 - Do NOT Maintain a Paper 
File! Fight the Paper  

To achieve effective time, document, and email management, we 
have to get organized. In order to resolve email without delay, you 
have to be able to find an answer quickly or know where you left off. 
If  your documents for the Jones case are scattered and you have to 
look in multiple locations, that is inevitably going to result in taking 
5 times as long to answer the question and delay your response to 
the email until you have 30 minutes to find the answer. Here are 
common areas where information is scattered and located: 

• In a paper file called “Jones, Bill - Tax Issue” 

• In an inbox 

• In an inbox subfolder called “Jones, Bill” 

• In a folder on the S drive: S:\Clients\Jones\General 

• In a folder on your laptop: My Documents\Firm Stuff\Tax 
Issues\Jones 

In order to be organized, we absolutely must figure out how to 
manage digital information in one central digital location. To make 
matters worse, many professionals still maintain a paper file as well.  
It is an enormous waste of  time and money to maintain a paper file. 
Paper files are nearly useless anyway in these post-COVID days. 
Only one person can access a paper file at a time, and it is extremely 
time consuming and costly to store all email and other information. 

Bottom line: Invest in a document management system and 
“Fight the Paper.” Save emails into a central repository, as described 
above. Ultimately, all emails and documents for a project, case, or 
matter should be stored in one central location for everyone on the 
team to access. Tools like NetDocuments, Worldox, and iManage are 
perfect for this situation.  Microsoft SharePoint may even be an 
option if  it configured correctly. 



 

APPENDIX 
 

TDC DAILY PLANNER 
The Tame the Digital Chaos (TDC) daily planner is designed to 

help you plan and maximize productivity on a day-to-day basis. 
These are undated pages that you fill out each day, as described above 
in Error! Reference source not found., Task Management - Daily 
Planning. A bound print version of  the planner will be available at 
www.pauljunger.com March 1, 2021, but in the interim feel free to 
print undated pages and fill them out daily.  Here is a sample 
completed page. The next 2 pages contain the unfilled and undated 
blank form.  Also consider the numerous paper-based planners on 
the market such as Best Self  Journal, Panda, etc. 

 

 

http://www.pauljunger.com
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Core Microsoft Productivity Apps 

 App iOS? Android 

 

Microsoft Word for iOS  
Allows you to edit Microsoft Word documents in their proper format. Free 
version allows viewing and basic edits. 

Y Y 

 

Microsoft Excel for iOS  
Allows you to edit Microsoft Excel spreadsheets in their proper format. Free 
version allows viewing and basic edits. 

Y Y 

 

Microsoft PowerPoint for iOS  
Allows you to edit Microsoft PowerPoint presentations in their proper 
format. Free version allows viewing and basic edits. 

Y Y 

 

Microsoft OneNote for iOS  
Type or handwrite notes in Microsoft OneNote. Collaborate/share 
notebooks with other users. Works across all ecosystems. 

Y Y 

 

Microsoft Outlook for iOS  
Outlook Calendar, Email, Contacts in mobile app. 

Y Y 

 

Microsoft ToDo 
Fantastic Task List/To Do List that synchronizes with your Outlook Tasks. 

 

Y Y 
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 App iOS? Android 

 PDF Apps   

 

PDF Expert – $9.99Y 
An excellent PDF viewer and annotator. Similar to GoodReader but also 
allows for filling out PDF forms and signing documents.  

Y N 

 

GoodReader 
One of the original PDF viewers and annotation tools. Solid choice and good 
alternative to PDF Expert. 

Y N 

 

PDFelement 
Excellent PDF viewer and annotator for Android devices. 

 

N Y 

 

PDF Max 
Excellent PDF viewer and annotator for Android devices. 

N Y 

 Litigation or Legal-Specific   

 

Fastcase – Free 
Legal Research 

Y Y 



4 

 App iOS? Android 

 

TranscriptPad – $89.99 
Best transcript management app for the iPad. Transcripts must be in the 
.txt file format. 

Y N 

 

TrialDirector – Free 
The companion iPad app for the desktop TrialDirector software. 

Y N 

 

TrialPad – $129.99 
Best trial presentation app available for the iPad. 

Y N 

 

Case Notebook E-Transcript – Free 
App that will accept and let you read E-Transcript files (.ptx).  Cannot 
organize transcripts by case or issue code like you can with TranscriptPad. 

Y N 

 

iThoughts – $11.99 
A mind-mapping app for the iPad that allows you to visually construct your 
notes and thoughts.  

Y N 

 

LawStack – Free (but individual books are IAP) 
Free app that allows you to purchase books that you need to carry around 
with you such as the Federal Rules of Civil Procedure. Updates happen 
through in-app updates. 

Y N 
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 App iOS? Android 

 

MindNode 6 – Free ($9.99 IAP) 
Mind-mapping / brainstorm alternative to iThoughts. 

Y N 

 

 

Mindomo 
Mind-mapping app for Android devices. 

N Y 

 Cybersecurity & Password Management   

 
Nord VPN ($3.99/mo) 
Nord VPN gives you access to one of the best and easiest VPN services. 

Y Y 

 

TunnelBear VPN – ($4.99/mo) 
The TunnelBear app gives you access to one of the best and easiest VPN 
services.  

Y Y 

 

Dashlane Password Manager (Free - $59/yr) 
Highly rated password manager app that syncs with your PC, Mac, iPhone 
or Android-based phone. 

Y Y 

 

LastPass Password Manager (Free - $35/yr) 
Highly rated password manager app that syncs with your PC, Mac, iPhone 
or Android-based phone. 

Y Y 
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 App iOS? Android 

 

1Password – $3 & up per month 
The 1Password app syncs with your Mac and Windows desktop software to 
ensure that you have access to all of your passwords from any device.  

Y N 

 

Authy – Free 
Two-Factor Authentication 

Y Y 

 

Google Authenticator - Free 
Two-Factor Authentication. 

Y Y 

 Mobile Scanning   

 

Scanbot - Scanner App PDF OCR – Free (IAP) 
"Scan" documents by using the iPad's camera and create PDF files. Pro 
feature upgrade includes ability to OCR documents.  

Y Y 

 

Scanner Pro 
Fantastic scanning app for scanning that includes OCR.  Scanner Pro is 
available on Android devices, but from a different maker (AppDev 
Technolabs) 

 

Y Y 

 

ScanBizCards – Free to $5.99 
Scan and convert paper business cards to your electronic address book 
(Apple, Outlook, etc.) 

Y Y 
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 App iOS? Android 

 Note-Taking Apps   

 

GoodNotes 5 – $7.99 
Another excellent note-taking app that can also convert your (legible) 
handwriting into editable text.  

Y N 

 

Evernote ($4.99) 
Cloud notes, organizer available on the web, iOS or Android. 

Y Y 

 

Microsoft OneNote for iOS  (part of O365) 
Type or handwrite notes in Microsoft OneNote. Collaborate/share 
notebooks with other users. Works across all ecosystems. 

Y Y 

 

Notability – $9.99 
One of the best apps for typing and handwriting notes on the iPad. Can also 
record audio while you take notes and syncs the audio with your notes. 

Y N 

    

 Other Law Office Business Apps   

 

AnyList – Free ($9.99/$14.99/yr IAP) 
Grocery List to share across family and iOS & Android. 

Y Y 
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 App iOS? Android 

 

Apple Maps – Free 
If you use an iPhone and an Apple Watch, the Apple Maps apps is fantastic 
because it communicates with the watch, causing to vibrate, letting you 
know whether to turn left or right at a particular intersection. 

Y N 

 

AroundMe – Free ($2.99 IAP) 
Find businesses around you. Quickly identifies your position and allows you 
to choose the nearest Bank, Bar, Gas Station, Hospital, Hotel, Movie 
Theatre, Restaurant, Supermarket, etc. 

Y Y 

 

Audible – Subscription Service ($16/mo.) 
Audio Books 

Y Y 

 

Amazon Kindle – Free 
Still one of the best options for e-books, the Amazon Kindle app is free for 
iPhone and iPad.  

Y Y 

 

Calcbot 2 – Free 
Intelligent calculator and unit converter for the rest of us. 

Y N 

 

Dictate + Connect – $16.99 
Dictation on the iPhone or iPad.  Alternative on an Android device is Voice 
Notes (see below). 

Y N 
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 App iOS? Android 

 

Dictionary.com – $3.99 
We all need access to a good dictionary, and the Dictionary.com Pro app for 
the iPad is one of the best.  

Y Y 

 

Duck Duck Go – Free 
Track free searching.  GREAT alternative to Google. 

Y Y 

 

iTimeKeep - $499/yr annually 
Timesheets on your mobile device that has direct integration with your 
time, billing & accounting system. 

Y Y 

 

iMovie – Free 
Video recorder and editor.  Android alternative is VideoPad. 

Y N 

 

Just Press Record - $4.99 
(or Apple’s Voice Memo app) 

Y N 

 

NetDocuments – Subscription 
App for their cloud-based legal document management system.  
Competitors are Worldox, iManage and OpenText. 

Y Y 
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 App iOS? Android 

 

OmniFocus – Free ($49.99/$74.99 IAP, or $9.99/mo. 
Including Mac and web access) 
Personal task managerY 

Y N 

 

Overcast – Free ($9.99 IAP removes ads) 
The app for listening to podcasts on your iPhone or iPad. You can speed up 
the audio so that it takes less time to listen to a podcast.  Google Podcasts is 
good alternative for Android devices.Y 

Y N 

 

OverDrive – Free 
Borrow eBooks, audio books and streaming video on your iOS or Android 
device. 

 

Y Y 

 

Pinner for Pinboard ($4.99 + Pinboard subscription 
($11 or $25/yr) 
Bookmark tagging and organizing. 

Y Y 

 

Productive – Habit Tracker – Free (various IAP) 
To Do List and Goal Planner 

Y N 

 

Reeder 4 – $4.99 
Many of us still subscribe to RSS feeds to stay on top of the news every day, 
and the Reeder app is one of the best options for the iPhone and iPad. 

Y N 
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 App iOS? Android 

 

Signal - Private Messenger – Free 
Encrypted Private Messenger.  Alternative – WhatsApp. 

 

Y Y 

 

Soulver – $2.99 
Text editor and calculator. Use words alongside numbers and do 
calculations over multiple lines.  Ingenious alternative to a calculator. 

Y N 

 

Speedtest by Ookla – Free 
Test internet speed on web or from app. 

 

Y Y 

 

Syncronicity Pro for Exchange - $4.99 
See other team member calendars if using MS Exchange. 

Y N 

 

Time Jump – Date Calculator – $2.99 
Date calculator (i.e. Calculate 28 days from today) 

Y N 

 

VideoPad – Free 
Video editor for Android. 

N Y 
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 App iOS? Android 

 

Voice Notes – Free to $59.99 
Quick recording of ideas.  Also does voice to text. 

N Y 

 

Zones – Free ($2.99 IAP) 
Time Zone Calculator 

Y Y 

    

 Other Miscellaneous   

 

Blood Pressure Companion Pro – $0.99 
Bluetooth-based blood pressure tracking. 

Y N 

 

Cash App (by Square Inc.) – Free 
Transfer funds to family/friends/vendors. 

Y Y 

 

Dark Sky Weather – $3.99 
Award winning weather app. 

Y Y 

 

Dexcom – Free 
Continuous Glucose Monitoring Health App. 

Y Y 
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 App iOS? Android 

 

Disney+ – $6.99/mo. Y Y 

 

Felt – Free (but approx. $3.99 to send each card) 
Everyone likes to receive handwritten notes in the mail, but what if you 
don’t have fancy stationery and envelopes? Use the Felt app to handwrite a 
note on your iPad and pick a lovely card – they’ll send it for you!  

Y Y 

 

HBO GO / Cable & TV Apps Generally – Free (requires a 
subscription) 

Y Y 

 

HomeKit / Smart Home Apps – Free 
There are a slew of apps that let you control lights, outlets, door locks, 
thermostats, and security cameras, among other things, from your phone. I 
personally use Philips Hue Lights and an Ecobee thermostat. 

Y N 

 

iExit Interstate Exit Guide – Free 
iExit tells you what's at upcoming exits when you're on the highway. It uses 
your device's location to determine where you are on the highway 

 

Y Y 

 

inRoute Route Planner – Free (IAP) 
Plan optimal routes or chart your own course using weather, elevation, 
curves and more. Then navigate safely with voice-guided, turn-by-turn 
directions that automatically check your route for severe weather.  Great 
alternative available on iOS and Android is Waze (see below). 

Y N 
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 App iOS? Android 

 

Instapaper – Free (IAP) 
Save and store articles for reading: offline, on-the-go, anytime, anywhere, 
perfectly formatted 

Y Y 

 

Key Ring Rewards Cards – Free 
Add all your reward cards to the Key Ring app and stop carrying around a 
hundred-pound key ring with dozens of reward cards. 

Y Y 

 

MLB At Bat – Free (requires a $20/yr subscription) 
Essential for baseball fans. 

Y Y 

 

Prime Photos from Amazon – Free 
Store, backup and organize photos. 

Y Y 

 

Spotify – Free (requires a paid subscription) 
Digital Music Service 

Y Y 

 

Tasty – Free 
Fantastic video recipes. Other great sources are Epicurious & Food 
Network. 

Y Y 

 

The Athletic – Free (requires $9.99/mo. subscription) 
Sport Journal for die hard sports fans.  North American coverage. 

Y Y 
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 App iOS? Android 

 

Tinybeans Baby Memory Book – Free (also subscription 
@ $8/mo. or $50/yr.) 
Highly rated family journal and photo album. 

Y Y 

 

Waze – Free 
Excellent route planner and GPS navigation.  Alternative to Apple Maps, 
Google Maps, inRoute, etc.  

Y Y 

 
*IAP = In App Purchase 
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 EXERCISE 1 

Starting a Presentation – Creating a Title Slide 

 
1. When PowerPoint starts, a brand new presentation opens with a blank first 

slide. 
 

  

 
 

2. Right-click and select Layout and select the desired slide layout. 
3. Click in the area that says “Click to add title.”  Enter some text as a title for 

this presentation.  
4. Click in the area that says “Click to add subtitle.”  Enter some text as a 

subtitle for this presentation.  
5. In the Ribbon above, select the Design tab.  Here you can choose a pre-fab 

cliché run-of-the-mill boring background for your PowerPoint presentation. 
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Saving Presentation as a Template 

1. Once you have formatted the color, font and created the desired graphical 
layout that you like, you may want to save it for later use.  To do so, select File 
and  Save As and then select PowerPoint Template (*.potx). 
 

 
2. To access/use that template, select File > New and My Templates. 
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EXERCISE 2 

Creating a Bullet Point Lists 

1. On the Home ribbon, select the New Slide button. Select Title and Content. 
 

 
 

2. The new bullet list slide will be inserted as the second slide.  Now click in the 
Click to add title area and add some text as the heading for the bullet list. 

3. Click in the bulleted Click to add text field and add the first of your bullet 
points.  Hit Enter to advance to the next line and add additional bullets.  

4. To change the appearance of the bullets in the list, click and drag your mouse 
over the bullet points you have created to select the text. From the Home 
ribbon, click the drop-down menu from the bullet-point toolbar button and 
select the desired bullet style.  
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5. To animate your bullet list so each one comes in one at a time, select the 

Animation ribbon and then Custom Animation.  In 2010, the custom 
animation is found under the Animation ribbon and Add Animation. 
 
 

 
 
 

6. The Custom Animation task pane will appear on the far right hand side of the 
screen.  Select the desired bullet points to animation as seen below. 

7. Next, select which kind of custom animation you would like for that bullet point 
from the Add Effect drop down menu on the far right hand task pane. Repeat 
for each bullet, if desired.  In the future, it may best to animate the first bullet 
point and then when you hit Enter a new bullet point is created with the 
animation, so you do not have to animate each bullet separately. 
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EXERCISE 3 

Slide Transitions 

  To give your presentation a really cool feel, you can apply what is called a transition 
between slides.  As an example, this could add a fading effect between slides.  You also can 
add a checkerboard, sliding, and many other effects.   
Select one of the buttons seen below (with the shorter red arrows) and then apply to the slide 
you are actively working on, or to all..  PowerPoint 2007 will show you a preview dynamically.   
 

1. On the Animation ribbon, select the desired transition and click Apply to 
All. 
 

 
In PowerPoint 2010, transitions is a dedicated Ribbon: 
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EXERCISE 4 

Inserting Clip Art & Photographs 

Available Options 
Various types of clip art and picture formats can be inserted into a PowerPoint 
slide.  The most typical file type is the jpeg format. Clip art consists of pre-made 
graphics to use at any time. Pictures can be scanned images, photos from a 
digital camera, pictures downloaded from the web, or other sources. 

Inserting 
1. To insert clip art go to the Insert ribbon and click on the Clip Art toolbar 

button. 
 

 
  
 
 
 

 
2. A task bar will come up on the right side which you can search for any clip art 

you would like to insert. 
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3. To insert a Photograph go to the Insert ribbon and click Picture.  Browse to 
the location where the graphic file resides.  You can either double-click on the 
file or select it and click Open at the bottom of the dialog box. 
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Changing your background slide color to Black 
Often times, it is desirable to make the background color black when displaying 
photographs or clip art.  White tends to be harder on the eyes and black just 
displays the image better most of the time. 

1. Right-click on the background and select Format Background. 
 
  
  
  
  
  
  
  
  
  
  
  
  
  

2. Select the desired color and click Close to apply the color to just that slide, or 
select Apply to All to apply to all slides. 
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Inserting PDF Images into PowerPoint 

Inserting an image from a PDF is unfortunately not an option from within 
PowerPoint.  A portable document format (PDF) is not a true graphic file.  
However, since many people have documents or images provided to them in 
PDF format, below are instructions for getting those PDFs, or parts of PDFs, into 
PowerPoint without having to re-scan the document or image. 
 
1. Open the PDF file in Acrobat. 
2. Use the Snapshot tool in Acrobat (select the Snapshot toolbar button (the 
camera) or from the menu bar, select Tools, Basic, Snapshot Tool).  Clicking 
on the image with the cross hairs selects the entire image.  Dragging the cross 
hairs allows you to crop and select the image. 

 
 

 

 

 
 
 
 
 
 

3. Adobe will prompt you to inform you that the image is saved to the Windows 
Clipboard.  Select OK. 

4. Return to PowerPoint and select Paste or Ctrl+V to paste the image into the 
desired slide. 
 
 



PowerPoint for Lawyers  Page 11 of 44 
 

Resizing Clip Art or Photographs 

PowerPoint may insert the picture in a size that doesn’t fit.  Depending upon the 
resolution of the picture inserted, it may be too small or too large.  Inserted 
pictures can be easily resized by using the same method as resizing Clip Art 
images.  Use your mouse to click and drag the resizing handles. Always use the 
corners to resize images  so you do not skew the image.  The entire picture 
position on the slide can also be moved by clicking and dragging the image itself 
to another location on the slide. 

 

 
 

Adjusting the Quality of Photographs 

You can adjust the quality of photographs by double-clicking on the photo and 
going to the Format tab and ribbon.  You will see a group called Adjust.  Here 
you can adjust the brightness, contrast and color.  You can also decrease the 
size of your PowerPoint file by using the Compress Pictures function. 
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Inserting Large Numbers of Photos All-at-Once 

1. Open PowerPoint and select Photo Album from the Insert ribbon. 
 

 
 

2. Select File/Disk and then browse to the location of your digital photographs.  Select the 
desired photographs (TIP - CTRL-A will select all) and click Insert. 
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3. Here, you can re-order them, rotate, adjust brightness and contrast.  Select Fit to slide 
in the Picture Layout field and then click Create to create the presentation.   
 

 
 
 

4. If you want to use these slides within an already-existing PowerPoint show, save this 
one and exit.  Note the location.  Open your other PowerPoint file and from the Home 
ribbon, select New Slide and Reuse Slides.  Browse out to the photo album that you 
just created and insert all or just the desired slides. 
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Inserting Labels, Captions using Text Boxes 

1.  Click on Insert ribbon and then the toolbar button called Text Box. 
 
 
 
 

2. Move your cursor where you want to place the text box and left mouse click. 
3. Type the desired text and format it appropriately (i.e., color, font and size). 
4. Finally, drag (move) the box (like any other object) to its final placement so it 

looks nice. 
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EXERCISE 5 

Creating Document Callouts 

1. Scan the document that you would like to use and save it in as a TIF. 
2. As we did earlier, go to the Insert ribbon and click Picture.  Browse to the 

location where the document, saved as a TIF, resides.  You can either double-
click on the file or select it and click Open at the bottom of the dialog box. 
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3. The document will appear.  Resize it so it fits on the page and duplicate it by 
clicking on it, copying it, and pasting it so there are two of the same objects on 
the slide.   
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4. Double-click on one of the images to get the crop tool to appear from the 

Drawing Toolbar.  Create the “Callout” by cropping the copy using the crop 
tool.   
 

 
 

5. After you have cropped the callout, you can resize it (making it larger) just like 
we did previously with the picture. 
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6. You can animate the objects from the Animation  ribbon by going to Custom 

Animations or Add Animation button and choosing an entrance effect for 
each object. 
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7. If you want to you can also add a highlight with a transparent box. You must 
double click on the box after you have created the size of box you wish to 
have, then make it yellow (or any color that you wish to make it). Make it as 
transparent as you like using the scrolling bar. 
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Alternative Highlighting Method for Documents 
To achieve high-quality highlighting, it is best to bring the callout into a photo-editing 
program like Photoshop or Photoshop Elements, perform the crop and highlighting, 
and then save it as a separate JPG to be inserted.  This takes significantly longer than 
the above-procedure, but it provides an excellent result. 
 
An alternative purchasing a program like Photoshop or Photoshop Elements is using the 
Snipping Tool which is part of Windows Vista or Windows 7. 
 
To create a crop and highlight using the Snipping Tool: 
 

1. Open the document (as a TIF, PDF, JPG, whatever format) that you want to crop 
and highlight so that it is displayed largely on your screen. 

2. Start the Snipping Tool in Windows 7 or Vista. 

 
3. Draw a box around the area of the document that you would like to callout. 

 

 
 

Other Alternatives: 
• If working with a text-searchable PDF, apply the highlighting and then use the 

Snapshot tool. 

• If you have Sanction or Trial Director, you could apply highlighting in 
Presentation Mode and then save the image.  Browse to the saved location and 
then insert it into PowerPoint. 
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4. Using the Highlighter tool, highlight the desired area.  Then click on the Copy 
button (this will copy the image into the Windows Clipboard).  In PowerPoint, 
Paste the image into the desired PowerPoint slide and then apply an animation 
to the inserted image. 
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EXERCISE 6 

Inserting Video Clips 

1. From the Insert ribbon select Movie.  Browse to the location of the movie file, 
select it and click OK. 
 

 

 
The most common formats will be mpeg, or avi. 

 
After choosing the video you choose to insert you will get this message.  Most 
every time you will want to choose When Clicked (you don’t want it to start 
playing automatically when the slide appears … you may not be ready in the 
middle of your presentation). 
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EXERCISE 7 

Using Color & Animation to Fill Objects 

1. Insert a graphic file into your slide (Insert ribbon and Picture).  
 

2. Select Shapes, then Lines, and Free Form. 
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3. Draw the area that you want to fill with color using your mouse and left-
clicking around the shape. 
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4. Right-click on the drawn object and select Format Shape. 
a. Select the desired color in the Fill selection. 
b. Adjust the transparency to 40-60%. 
c. Select No Line in the Line, Color section. 

 

 
 

5. Repeat steps 3 and 4 as needed to fill in any other color in the diagram. 
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6. Select the first colored object that you would like to animate.  Add and 

animation such as Wedge or Fade.  Repeat for each area that needs to 
be introduced. 
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EXERCISE 8 

Inserting Sound Files 

1. Go to the Insert ribbon and select the Sound button. 
 

 
 

2. The most common formats are mp3, mpa, or wav. You will have to convert 
your sound file to those formats if you have a 911 call or a recorded message 
that you would like to play back.  You can use a program like Cakewalk Pyro 
(www.cakewalk.com) to convert an analog tape to digital. 

3. Locate the file and selecting the desired sound file and clicking OK. 

 
 

4. You will get the message once again about whether you want to automatically 
play or when clicked. Most every time you will want to choose When Clicked. 

 
5. After inserting the sound file you may want to add a picture, a label or an 

appropriate background. 
 

http://www.cakewalk.com/
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EXERCISE 9 

Flow Charts 

1. Drop in a rectangle or any other Shape from the Insert ribbon.  Type the 
desired text inside the rectangle and format the text appropriately.  
 

 
 
2. Take that rectangle and duplicate it (copy and paste).  
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3. Layout all of the objects and information you would like in your flow chart with 
the duplication of the boxes, lines and other objects.  Click inside the objects 
to modify the text as desired. 
 

 
 
4. Next, create the arrows you would like from the Insert ribbon and select the 

Shapes button and find the arrows. 
 

Duplicate the boxes by copying 
and pasting to save time.  Do not 
try to recreate the boxes. 
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Direction for Animation 

1. Go to the Animation ribbon and select Custom Animation. 
2. Select first box (object) and select Dissolve in under Entrance category.  
3. Next select first long arrow, and select Strips and then Left Down in the 

Direction drop-down menu.  
4. Now choose then next object to animate and repeat the process throughout.  
 
TIP:  If you animate the first object when you first start the slide, and you 

duplicate the objects (copy and paste), the animation will duplicate as well 
and can save you a good bit of time instead of having to animate each 
object at the end. 

 

Double-click inside the box and 
change this text to read “Children 
get $______” 
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EXERCISE 10 

Creating a Checklist 

1. Create two text boxes, one yes, one no (or whatever the categories you may 
need for your checklist). 

2. Create a border around the text box and select a fill color by right-clicking on 
the text box and selecting format shape.   
 

 
 

3. Create the categories that will go on the left.  For this, create one large text 
box and type your categories. 
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4. Create your rows of boxes under the YES, NO by copying the boxes you 
have already created. 
 

 
 
5. After you lay out all of the boxes where you would like them, you can put in 

the checks that you would like in your checklist.  Go to the Insert ribbon and 
select Clip Art.  If you type “check mark” in the search field, many options will 
appear. You can select the one you want and place it into the boxes. 
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6. Place that check mark anywhere you would like.  Simply copy and paste the 

check in all the other boxes that you would like.  
7. After you have all the check marks and the categories in the places you 

would like them, start custom animating them.  Select each category, and 
select the coinciding check mark and use the wipe left animation. 

 
 

8. Repeat as necessary. 
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EXERCISE 11 

Creating an Animated Family Tree or Organizational Chart 

1. When creating this type of chart, always start with the top person in the 
chart.  Type out the name, and insert his/her picture if you have it. 

2. Next, drop in the arrows to go to the next people in line.  Create the 
arrows as desired and then select them to apply animation to them.  Go 
to custom animation, select entrance and choose wipe – then down. 
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3. Create the next two or however many people you have on the next level, 

the same way you created the first one. This time, for purposes of this 
exercise, apply the custom animation on both of the new items. Select 
both at the same time and select custom animation – entrance – faded 
zoom.  
 

 
 

4. Finish it out by creating your final arrows and your final names the same 
way you did the previous ones. 
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EXERCISE 12 

Creating a Timeline 

1. To create a timeline, create line across the slide and label the start and 
end date using text boxes.  To create a line, go to the Insert ribbon and 
the Shapes button – and select the line button, and drag it across the 
screen.  
  
  
  

 
2. Choose the dates that you want to create and type them into each of their 

own text boxes and place them appropriately on the timeline. 
3. If you want to pop up pictures or documents on those dates or even just 

comments on those dates, you can make a line going from the timeline 
and connect it to the document, picture or comment.  

4. After you do this, group the objects together, so when they pop up they all 
pop up simultaneously. To group you can select all of the objects by 
holding down the Shift key and left-clicking on the objects.  Then right-
click on one of the selected objects and select grouping and select 
group. 
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5. Use an animation (entrance - wipe up) on the group. 
6. Repeat as necessary. 
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EXERCISE 13 

Inserting Spreadsheets and Charts into PowerPoint 

There are several ways to insert an Excel spreadsheet into a PowerPoint 
presentation: 

• Create New – Spreadsheet is created from scratch and embedded into 
the PowerPoint slide and not hyperlinked to an external spreadsheet. 

• Create from file – Spreadsheet already exists and then is embedded into 
the PowerPoint slide and not hyperlinked to the source spreadsheet. 

• Create from file and Linked - Spreadsheet already exists and then is 
embedded as a hyperlink into the PowerPoint slide and is therefore 
updated whenever updated in either location. 
 

To Create New: 
1. From the Insert ribbon, select Object.  Select Microsoft Worksheet and 

Create new and then Ok. 
 

 
 



PowerPoint for Lawyers  Page 39 of 44 
 

To Create from File: 
1. From the Insert ribbon, select Object.  Select Microsoft Worksheet and 

Create from file and then Ok. 
 

 
 

To Create from File and Linked: 
1. From the Insert ribbon, select Object.  Select Microsoft Worksheet, 

Create from file, and then check the box labeled Link. 
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EXERCISE 14 

Using Design Templates & Themes 

One of the primary benefits of using a Theme (*.thmx) over a template (*.potx) is 
that you can apply the theme at any stage of building constructing your 
PowerPoint, and it will automatically update every slide in your presentation.  
Note, this could be bad also , requiring that you do a lot of tweaking and 
reformatting. 

1. Click on the Design ribbon. 

 
 

2. From Design Ribbon, select one of the Themes displayed in the ribbon.  
Note that this will affect every slide in your presentation.  It is generally 
recommended that you apply a Theme when you first create the 
presentation so that you do not overwrite any custom colors and fonts 
that you have created for special slides.  There are many Themes to 
select.  Below are just a few samples to give you an idea about how they 
differ.   
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Saving Your Own Theme 

One of the primary benefits of using a Theme (*.thmx) over a template (*.potx) is 
that you can apply the theme at any stage of building constructing your 
PowerPoint, and it will automatically update every slide in your presentation.   

1. After customizing the colors, design and desired effects, select File > 
Save As, and then select Office Theme under Save as type. 
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EXERCISE 15 

Inserting Image as PowerPoint Backdrop 

Sometimes, you may want to insert an image as a background or “backdrop” to a 
slide. Generally, photos do not make good backdrops, but custom made graphics 
can be provided to you in the form of a JPG, PNG, or other format. 
 

1. Right-mouse click on an open area within you PowerPoint slide and 
select Format Background.  Select Fill, then select the radio button 
Picture or texture fill and then File. 

 
 

2. Browse to find the image file and double-click to select it.  If you want to 
use that backdrop for just that one slide, click Close.  If you want to apply 
the backdrop to all slides, click Apply to All. 
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EXERCISE 16 

Adding “Animation” of Object to Existing Photograph 

In this example, we are going to give the illusion that blood is flowing through a 
vessel.  It requires that we first have two images – (1) a picture/graphic of a blood 
vessel, and (2) a picture/graphic of blood.  Both can be obtained through a 
licensed source of stock photography or graphics. 
 

1. Select a plain dark background free of any graphics (black is preferable). 
2. From the Insert ribbon, select Picture.  Browse to the graphic of the blood 

vessel and double-click to insert it into the PowerPoint slide: 
 

 
3. From the Insert ribbon, select Shapes.  Select the Scribble tool. 
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4. Using the pencil pointer, trace the edges of the blood vessel, as seen 
below. 
 

 
 

5. Right-mouse click on the drawn shape and select Format Shape.  Select 
Fill, and then the radio button Picture or texture fill and then File to 
browse to your blood graphic.  Double-click to insert the blood as a fill 
color for the blood vessel.  Select Line Color and then No Line.  Select 
Close. 

 
 

6. Animate the blood by selecting the hand-drawn shape, select Animation 
and then Custom Animation (Add Animation in PowerPoint 2010), then 
use the Wipe effect – direction from bottom. 
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Notifications - Settings
• File > Options > Mail
Turn off all Notifications!
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Email Rules

• Creating New
• The Rules Wizard
• Applying to Inbox
• File > Manage Rules & 

Alerts

Customizing Your Inbox
• The VIEW tab
Folder Pane
Previously “Navigation Pane”

Reading Pane
To-Do Bar
People Pane
Single Line
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Views
• Change View / Save View

New Message
• New Message – Often Not Used 

Features … Options >
– Showing BCC line
– Save Sent Item To
– Delay Delivery
– Direct Replies To
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New Message
• New Message – Often Not Used 

Features … Options > Encrypt

Quick Steps



10/22/2020

9

Create a Link in Email
Select Text > Right-click > Link
Paste Link in the Address field > OK

My Templates
Place cursor > View Templates > Select desired  Text to 
Insert
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Add to My Templates

View Templates > 
Add Template > Type 
or Paste Text 

Conversation Threads

• Combines conversation threads
• Easier to process email
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Auto Text
Copy Frequently Used Text 

New Email > Insert > Quick Parts > AutoText > Save 
Selection to AutoText Gallery

Conversation Threads

• Use the “Clean Up” to delete duplicates 
(on Home ribbon)
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Skip Salvage
• Permanently Delete Emails – Skip Salvage

• Shift + Delete

Signatures
• Options
• New Messages and Replies
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Out of Office
• Options for internal and external and

– Warning for Hosted Exchange
• Time Frames

• Warning from Inbox

Convert Email to Task
• Drag & Drop Email to Task Icon
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Convert Email to Appointment
• Drag & Drop Email to Calendar Icon

Calendar
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Calendar Options
• File Tab

– Options, Calendar
– Dialog Box Launcher (Arrange)

• Set work day hours
• Default Reminder Settings
• Default Color Scheme
• Other Preferences

Show Non-Adjacent Days
1. Ctrl+Click on Desired Days
2. View Results on Right
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Calendar Time Zones
• Multiple Time Zones

– File > Options > Calendar
– Show and Label

Date Calculator

• Calculating Dates (new appt + clear end time)
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Calendar Sharing
• Home > Open Calendar > Open Shared 

Calendar

Microsoft FindTime

https://Findtime.Microsoft.com

https://Findtime.Microsoft.com
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Calendar Searching
• Search – Simple Quick Search
• Advanced Find

– CTRL / SHIFT / F

Searching Outlook
• File > Options > Search
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Searching Outlook
• File > Options > Search > Index Options > Advanced 

> Rebuild (will take a while)

Tasks in Outlook
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Microsoft ToDo

https://todo.microsoft.com

Naming Tasks
• Using Prefix (client last name - )
• Describe + Next Action

https://todo.microsoft.com
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Create Task Lists
• Client – Admin – Personal – Business Dev
• Right-click on ToDo List > Create New Folder

Customizing Views
• Active Only (Change View)
• Select and Remove Desired Columns
• View Settings (do last)
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Tasks vs To-Dos
• To-Do List aggregates:

– Flagged Emails
– All Tasks from all Task Lists

Task Categories
• Use to Group Tasks & Operate from Shorter Lists to 

Focus
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Delegating Tasks
• Delegating Tasks

Delegating Tasks
• Delegating Tasks
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Sharing Tasks List
• Share Task List with your Team

Synching Tasks with iPhone
• Settings > Mail > Select Account 

(typically Exchange) > Reminders ON
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